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PortraitPro Body 3.6

Getting Started

Introduction

PortraitPro Body is the easiest and fastest way to re-touch full body portraits, allowing you to achieve
professional results in minutes.

PortraitPro Body works in a completely different way to ordinary airbrushing and warping software - it has been
trained with thousands of examples of human body shape and appearance.

Due to the innate knowledge of human beauty thatis builtinto PortraitPro Body, the highest quality full body
portrait touch-up can be achieved by anyone in just a few minutes.

PortraitPro Body is available in two editions: Standard and Studio. All editions are covered by this manual.

PortraitPro Bodyis available for Windows and Mac computers. This manual is for the Mac version of PortraitPro
Body.

Getting Started
Take a look at the Quick Start Guide[ 7Mto see a quick overview of how to use PortraitPro Body.
The Step By Step Guide[ 18 provides more detailed information about each step.

If you need further help, please visit http://www.portraitprobody.com/support/ where you can see the latest FAQ
and access our support ticket system. The support ticket system lets you send a question to our support staff.

© 2024 Anthropics Technology Ltd.
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1.1 Quick Start Guide

PortraitPro Body will guide you through the process of enhancing your portrait. You can use this quick start
guide to familiarize yourself with the stages.

When you open PortraitPro Body, you will see the main home page. Here you will find videos and tutorials that
allow you to learn about and try different functions of the software. We recommend that you work through some
of these components in the suggested order. However, if you want to start working on your own image straight
away then you should proceed as described below.

Select the image to enhance

Click on the New Image button, or select Open... from the File menu, or press CMD + O. This brings up the File
Open dialog where you can select the image you want to load.

PortraitPro Body will load your image and show itin the main working area.

Select the body you want to enhance

Click on the middle of the face of the person you want to enhance. Occasionally the software will fail to identify
the face and will prompt you to check again.

Selectthe gender of the person

Atthe prompt, select either male or female.

Automatic selection
The software will now automatically detect the shape and position of the body.

If you are happy with the automatic selection, click the Accept Markup button. Sometimes you may wish to
correct or refine the markup. In this case, click the Modify Markup button.

Modify the markup

The software will now guide you through the selection for each limb. To adjust the selection, simply use your
left mouse button to click on a point and drag it to the right position. If you make a mistake, you can undo the
change by pressing CMD + Z. Examples of the ideal joint positions are illustrated in the help panel on the right-
hand side.

To move on to the next limb, press the SPACE BAR or click the RIGHT ARROW. To go back to the previous limb
press ESC or click the LEFT ARROW.

Identify overlaps

The software will automatically detect when one limb is in front of another. To change this selection, use the
radio buttons on the left-hand side of the screen. The overlaps will be represented on screen for you to check.

© 2024 Anthropics Technology Ltd.
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4. adjust overlaps

] left lower leg in front of right lower leg

_:| right lower arm in front of torso

:I right upper arm in front of torso

:| torso in front of right upper leg

@] left upper leg in front of right upper leg

Once you're done, click the Accept Markup button below this menu.

Shape sliders section

The image is now readyto edit with the shape sliders[5Asection. You can change the shape of the body by
moving the sliders on the left-hand side. By opening the sections for torso, arms, legs or skeleton, you can
modify specific parts of the body. Collectively, these sliders allow a very fast method for getting the shape of the
body roughly correct. You can see the image before and after the changes by pressing ENTER or by clicking the
tab above the main image.

Shape tools section

Selectthe shape tools tab on the right-hand side. These tools allow you to make finer changes to the shape of
the body. The (default) edit bodyl@ tool allows you to directly use the mouse to drag the body contours to new
positions. You can also drag the joint positions to change the pose of the body. Other tools in this section
include:

o the drag tool[ 62 which allows you to drag any region of the image to warp it.

o the repairtooll?iﬁwhich fixes any problems or tears in the image introduced by the other tools.

Other editing sections

Other parts of the software (selectable by clicking in the control column) can be used to modify other parts of
the image:

o the skin section[ 64 allows you to smooth the skin on the bodyand also to improve the texture of the belly
area.

o the face section[ 68)allows you to airbrush and reshape the face to improve the appearance. (PortraitPro is
a standalone product that is specialized to this task and has many more options.)

o the picture section[ 7™ allows you to change global aspects of the whole image such as contrast and color
balance.

o the warp fixer[3 allows you to fix lines and other areas that have become distorted due to the body
warping.

Save project and image

When you are happy with the changes you have made, you can save the edited image by selecting Export Final
Image from the File menu or by clicking the appropriate icon from the toolbar at the top of the control column.
You can save the entire project (with file extension .prb) by selecting Save Project from the File menu or by
selecting the appropriate icon from the toolbar. This will allow you to return to this image and make further
changes at another time.

© 2024 Anthropics Technology Ltd.
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Other people in the photo

If there is more than one person in the photo that you wish to edit, export your image and close the session.
Open the newly saved image and select the next person to enhance.

© 2024 Anthropics Technology Ltd.
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1.2

Top Tips For Best Results

If you justread one page in this manual, make it this one to get the bestresults out of PortraitPro Body.

Make sure the skeleton joints and curves are accurately placed

You will get the bestresults if the outlines are accurately placed. Take a close look at the examples in the help
window on the right-hand side of the workspace. You can return to the markup stage to improve the markup at
anytime (although you will lose all changes to the body). Take particular care to ensure that the outlines around
the outside of the body follow the edge of the body.

Don't move the sliders too far

Often, you can greatly improve a picture with fairly subtle changes. Adjust the sliders just far enough to get the
results you want. If you go too far, the result can look unnatural or fake.

Don'tuse the sliders to make small shape changes

You can avoid the need to move the sliders too far by using the shape tools to make finer-scale changes to one
particular part of the body.

Fixing problems

You can fix regions that are torn or unrealistically warped using the repair tool[621in the shape tools section.

Make sure the skin area is right

In the skin section[ 64, PortraitPro Body automatically estimates which areas in your picture are skin. However,
you can sometimes improve the results by adjusting the skin area selected.

Use the skin select and deselect tools to paint over any skin areas that are wrong.

Fixing distorted backgrounds

If the background is noticeably distorted after warping the image, you can fix it with the repair and revert
tools [ 62 or the warp fixer[ 39,

© 2024 Anthropics Technology Ltd.



Getting Started 11

1.3 PortraitPro Body Editions

PortraitPro Body comes in two editions: Standard and Studio. The Standard edition is intended for more casual
users or amateur photographers. The Studio edition is intended for enthusiast or professional users.

This manual covers all editions. Features that are only available in some editions are indicated like this: Studio
Edition Only

The following table shows the main features of PortraitPro Body and which editions theyare in.

Standard Studio

x J Available as a smart filter in Photoshop

Available as a Lightroom External Editor

Read camera RAW format

Read Adobe DNG format

Read & write TIFFs and PNGs containing 16 bits per color

Support for JPEG, PNG and TIFF embedded color profiles

Supports conversion between different color spaces

Body shape editing

General warping tools

Skin smoothing

Stomach replacement

L4 44 X X X X X X
L S S G N G S S VA SN
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Eye enhancing

Face sculpting

Face smoothing

Warp fixer

Picture control tools

Read and write JPEG, PNG and TIFF formatimages

Lite mode

SR NN NENSE IR
LS S48 S K&

Free online support
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2.1

Step By Step Guide

This section of the manual describes the various stages that you may need to go through when you use

PortraitPro Body.

There are two parts of the program:

o inthe markup stages[ 49, the image is annotated by the user with the joint positions and curve positions.

o in the enhancing stages[ 54, the image is manipulated to create the desired effects.

Open an Image

The PortraitPro Body Home Screen

When you run PortraitPro Body, it begins with the home page:

Y| PortraitPro Body 3

=
I

recent fil

Open an image

To open an image to enhance:
0 Selectthe Open command in the File 481 menul48).
o Alternatively, click the button marked open image.

This will bring up the Open Image or Project window.

Browse to the file you wantto enhance and press the Open button.

Image types that PortraitPro Body can open.[79

© 2024 Anthropics Technology Ltd.



Step By Step Guide 15

Lite mode
To open an image in lite mode click the button open image (lite mode).

Note that you cannot open images in lite mode from the File menu.

Open a project

If you have previously saved your work as a project or session file (.prb), you can open itand resume editing
from the same point. To open a project click the button open project.

2.2 Open anImagein Lite Mode

Lite mode allows you to make quick adjustments to your image without needing to mark itup. To open an
image in lite mode, select open image (lite mode) from the homepage and choose an image.

You will see the following in the control column:

markup

picture

You can still use the following:

0 Some ofthe shape tools.

© 2024 Anthropics Technology Ltd.



16 PortraitPro Body 3.6

0 Most of the skin section features (skin is still automatically detected).
o All of the picture section sliders.

Various sections and tools are unavailable since there is no information about the body in the image. If you
decide you want to markup your image later, you can click on the markup section. Note that this will clear any
changes you have made.

© 2024 Anthropics Technology Ltd.
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2.3 Plug-in Mode

Using the PortraitPro Body Plug-in
Studio Edition Only

The Studio edition of PortraitPro Body can enter a "plug-in mode". This is intended for use when PortraitPro
Body has been launched by another application (such as Photoshop) to enhance an image thatis being
managed by the other application. PortraitPro Body then behaves like a plug-in to the other application.

After the plug-in has been successfullyinstalled as outlined in the Plug-in Installation Guide[74), you will be
able to use PortraitPro Body as a plug-in in any of the supported photo editing applications.

When PortraitPro Body is run as a plug-in from another application, the image or layer in the other application
will automatically be loaded into PortraitPro Body where you can enhance the bodies in the usual way. Once
you are happy with your results, select Save and Return from the File menu or click the close button on the
toolbar. This will close PortraitPro Body and return the enhanced image to the original application.

When PortraitPro Body s in plug-in mode, the only command in the File menu is return from Plug-in and
several of the toolbar controls are also not selectable.

Using PortraitPro Body from Photoshop

When the plug-in has been installed, PortraitPro Body will appear as a filter in Photoshop. In the Photoshop
Filter menu, you will find a sub-menu called Anthropics, and in that you will find PortraitPro Body.

The PortraitPro Body filter works like other Photoshop filters in that it is applied to the current selection (or the
whole area if there is no selection) on the current layer. When you select the filter, the image being filtered will
automatically be opened in PortraitPro Body.

& QT s Thunas O =

W Photoshop CC File Edt Imoge Layer Type Select Q@ 30 view window Heip
L] t Files prpe.

Corwert for Smart Finers = L]

Filter Gallery..

Adaptive Wide Angle_.  TOMA
Camera Raw Fiter._.

Lens Correction,

Liguity...

Varishing o

an

Bk
Bhr Gallery
Distort
e
Phiziate
Aandar
Sharpen
Styize
Videa
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LangscipePra
Fartraitfr
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‘Smart Phosa Editor
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Plug-in Location: Filter > Anthropics > PortraitProBody
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2.4 Markup the image

Before the image can be edited, we mustfirst tell the software which person in the image we wish to work on,
their gender and the positions of the joints and body curves.

241 Selectthe face

After opening the image, the markup process starts.

Throughout the markup process, a panel on the right-hand side of the window gives instructions and provides
guidance for unusual cases. Apanel on the left-hand side of the window shows your progress.

To identify the person that you want to edit, move the mouse over the center of their face (the tip of the nose
works well) and click the image. If the face is identified successfully by the software you will now be asked to
identify the gender.

click onnose
to choose subject’

© 2024 Anthropics Technology Ltd.
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Occasionally, the software will fail to identify the face based on your click. This often happens when the face is
close to profile or is partially obscured by hair or another object. When this happens, the software will prompt
you to check if you selected the right subject.

Alternatively, the face may not have been detected because you clicked on the wrong image position in the first
stage. If this is the case, you can undo your change by selecting Undo from the Edit menu or using the shortcut

CMD + Z.

2.4.2 Choose gender

The next step is to identify the person as being male or female. This is done via a simple dialog boxwhich is

superimposed on the image.

© 2024 Anthropics Technology Ltd.




20 PortraitPro Body 3.6

navigator

To selectthe gender, click on the picture of the male or female body.

If you make a mistake, you can return to this part of the program by clicking on choose gender in the markup
menu on the left-hand side panel.

2.4.3 Adjusting the Markup

Once the gender has been selected, the software will automatically detect the position of the limbs and bodyin
the image. The markup is represented by different colored outlines for each limb.

@

navigator

markup

© 2024 Anthropics Technology Ltd.
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In most cases the software will locate the position of the body accurately and you can simply click accept
markup and edit body to progress to the editing stage. For more complex poses you may need to make some
adjustments. In this case, click (modify markup) to be taken to the markup stage.

The software will now guide you through the selection for each limb. To adjust the selection, simply use your
left mouse button to click on a point and drag it to the correct position. If you make a mistake, you can undo the
change by pressing CMD + Z. Examples of the ideal joint positions are illustrated in the help panel on the right-
hand side.

To move on to the next body part, press the SPACE BAR or click the RIGHT ARROW. To go back to the previous
limb, press ESC or click the LEFT ARROW. You can also skip to a specific limb by clicking its colored number
in the adjust body panel on the left-hand side.

Once you have finished making adjustments to the markup, you can move on to identify any areas where limbs
overlap by clicking adjust overlaps or simply accept the markup and progress to the editing stage.

Identify overlaps

The software will automatically detect when one limb is in front of another. To change this selection, use the
radio buttons on the left hand side of the screen. The overlaps will be represented on screen for you to check.

Once you've finished making your adjustments, click accept markup and edit body to begin editing the image.

© 2024 Anthropics Technology Ltd.
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24.4

245

Finishing markup

When the markup is complete, a dialog box will appear asking if you wish to move to edit mode or to continue
marking up the image.

Under normal circumstances, simply move on to the edit mode. However, if you know that you have made a
mistake in the markup stages, clicking the other button gives you the opportunity to correct any mistakes.

Correcting markup

Itis possible at any point to go back to markup stage although with practice this is rarely necessary.

o From editing modes, click the markup section in the control column (all edits to the image will be lost).
Then click on the relevant section (select face, choose gender, etc).

o From markup mode, click directly on the section (identify subject, choose gender, etc) in the control
column.

Markup mode works slightly differently when we return to it. Rather than marking the image with a series of
sequential clicks, itis possible to change any aspect of the markup at anytime. The following sections
describe each stage in turn.

Identify the subject

You can adjust the face points by clicking and dragging the two controls on the face oval. The face oval should
roughly surround the face in the image.

© 2024 Anthropics Technology Ltd.
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W

navigator

| shape tools
skin
face
warp fixer

picture

Choose gender

To selectthe gender, click on the picture of the male or female body in the pop-up window.

If you make a mistake, you can return to this part of the program by clicking on choose gender on the left-hand
side panel.

Adjust body

When we return to the body markup stage, we still deal with the curves one body part ata time, but now we can
adjust any of the points on the curves by clicking on them and dragging.

To move between body parts, press the SPACEBAR or click the right arrow to move to the next part or
BACKSPACE or the left arrow to move back. You can also identify the desired body part on the curve widget on
the left-hand side.

© 2024 Anthropics Technology Ltd.
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Identify overlaps

To change the interpretation, click on the list on the left-hand panel to toggle between which body partis in front.

Moving to edit mode

When you have finished making all the changes you want, click the button in the left-hand panel corresponding
to the edit mode (e.g shape sliders or skin) that you wish to move to.

The software will then re-do its analysis and you can begin editing again.

© 2024 Anthropics Technology Ltd.
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24.6 Common markup mistakes

In general, placing the curves with great precision is not necessary. As long as the skeleton points and curves
are in roughly the correct place, the editing functions will work satisfactorily.

There are however, two common pitfalls:
0 When the subject faces away from the camera, make sure to mark the right arm points on the right-hand
side of the image (as opposed to the left-hand side as is normal). The software will know that the person

faces away from the camera and identify the center as 'back’ rather than ‘chest.

o Be careful to identify the overlaps correctly -- if you make a mistake here, it means that some useful curves
will not be visible in the editing stages and other erroneous curves will appear.

© 2024 Anthropics Technology Ltd.
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2.5

Editing the image

Once we have marked up the image, itis now ready to manipulate. After a short processing interval, the
software will move to editing mode and a number of different sections appear in the control column. These
sections comprise:

o Shape sliders[28)
0 Shape tools [ 30)
o Skin[34)

o Facel 38

o Warp fixer[ 39

o Picture[ 7R

After finishing the markup stages, the shape sliders section will be open. To move to one of these sections,
simple click on its name. Clicking on the markup section will return you to the markup stage and undo any
work you have done.

NEEEEE {

navigator

markup

shape sliders

shape tools
skin
face
warp fixer

picture

Each of these sections has a number of controls and two buttons that are visible in the title bar when itis open.
The first button allows you to turn the effects of this section off (shape sliders and shape tools are connected in
this regard). To reset the effects of a section, press this button (it will change from green to red) and then start
again. The second button activates the help system which explains the controls in the panel.

shape sliders

In addition, the main editing page contains several other controls. There is a tab above the main image that
allows you to flip between the original and edited image (it will do nothing until you make some changes).

© 2024 Anthropics Technology Ltd.
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Pressing the ENTER key achieves the same result. There is a second tab at the extreme left of the screen that
allows you to see the original image next to the edited image (clicking on ittwice removes the original image
again).

Li) Pc
File Edit View Help

Finally, there is a toolbar which contains buttons for:

Home / Close -- close the current project and return to home screen

Save Project -- save the current project

Export Image -- save the edited image

Share -- post a before / after picture to Facebook

Undo -- undo the last change

Redo -- redo the last undone change

Help -- opens a context sensitive help that guides you around the screen

Lock -- locks the toolbar so thatitis always visible or unlocks it so that it only appears when the mouse is
close

O OO0 O0OO0O0Oo0oOo

© 2024 Anthropics Technology Ltd.



28 PortraitPro Body 3.6

2.5.1 Shapesliders

In the shape slider mode, itis possible to make large manipulations to the shape of the body by simply moving
the sliders in the control column.

The sliders are separated into several different sections.
There are four sliders at the top of the section make large scale changes to the entire shape:

Slim -- makes the entire subject thinner

Curvwy (women only) -- narrows the waist and expands the chestand hips
Built (men only) -- slims the stomach and broadens the shoulders

Lift -- raises the bottom / chest areas

Tall -- extends the legs and the torso length and stretches the neck

O OO0 oo

NEENEE f

navigator

markup
shape sliders

slim

shape tools

skin
face
warp fixer

picture

Below these sliders, there are four sections dealing respectively with the torso, legs, arms and skeleton. Each
section can be opened to reveal more sliders by clicking on the title or triangle, and subsections can be
opened in the same way to edit progressively finer parts of the body.

© 2024 Anthropics Technology Ltd.
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navigator

n

—e

mark up

The sections comprise

Torso -- allows editing of the hips, waist, chest etc.

Arms -- allows editing of the upper and forearms, elbows, wrists etc.

Legs -- allows editing of the upper legs, thighs, knees, lower legs and ankles

Skeleton -- allows movement of the joints to achieve various effects, including lengthening the legs, tilting
the hips and extending the neck

o
o]
o]
o]

For further information, consult the shape sliders reference[ 57

© 2024 Anthropics Technology Ltd.
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252

Shape tools

The shape tools section provides a number of tools for editing the shape of the person in the image by directly
manipulating the image. In general, these tools make finer scale changes to the image than is possible with
the shape sliders.

Edit body tool

When this tool is selected and the mouse is moved over the image, the curves on the edge of the body will be
highlighted. You can use this tool to pick up the curves and move them. The program knows about the statistics
of human body shape and so ittries to find a solution thatis compatible with the current mouse position as
well as being sensible. So, for example, if you move the left-hand side of the torso in then the right-hand side of
the torso will also move in. Once a pointhas been moved, itis fixed unless another pointis placed nearby.

When the move curves tool is selected, itis also possible to move the skeleton joints, which are represented
as colored dots at the joint positions. To move the joints, simply drag them to a new position.

Edit body local tool

The local curve tool allows you to make fine scale local changes to the curve. To move a curve, simply click on it
and move the mouse to drag itto a new position. Only curve positions very close to the mouse will be affected.
When this tool is selected, a slider will appear that controls the size of the region over which the local change is

affected.

© 2024 Anthropics Technology Ltd.
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Drag tool

The drag tool can be used anywhere in the image -- itis used to locally change the shape of the image by
clicking and dragging the mouse. Acircle surrounding the cursor allows you to visualize the area which will be
dragged. When this tool is selected, sliders appear in the control column that control both the area over which
the change is made (tool size) and the strength of the change (tool strength).

i}//

Expand tool

The expand tool can also be used anywhere in the image and causes a local expansion within the circular
cursor region when the mouse is held down. When this tool is selected, sliders appear in the control column
that control both the size of the brush and the strength of the effect.

Contract tool

The contract tool can also be used anywhere in the image and causes a local shrinking within the circular
cursor region when the mouse is held down. When this tool is selected, sliders appear in the control column
that control both the size of the cursor and the strength of the effect.

© 2024 Anthropics Technology Ltd.
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Repair tool

The repair tool fixes problems with the shape of the image by making the shape changes locally smooth within
the circular window. Occasionally, movement of the sliders or use of the other shape tools will cause tears,
discontinuities, or unrealistic shape changes. Applying the repair tool by holding the mouse down over the
desired area, will gradually fixthese problems. When this tool is selected, sliders appear on the control column
that adjusts both the size of the cursor and the strength of the effect.

If the SHIFT button is held down, the repair tool switches to the revert tool. This has the effect of locally
restoring the shape of the image to its original state. As well as meaning that the shape changes are locally
smooth, it also returns objects to their original position.

Fixbulges and pinches tool

The fix bulges and pinches tool is a very specific tool for sorting out problems in the shape that are at a finer
scale than the curve tools can deal with. Typically, it would be used to reduce bulges at the hips or creases due
to fat or a tight bikini strap. To operate the tool, move the cursor over one of the existing curves. The region
under consideration is blown up and the shape is visualized before and after the change. Pressing and holding
the mouse button causes the shape change to be made. Essentially, the local shape of the contour in the
image is estimated and warped towards the smoother (but usually more desirable) curves that were drawn in
the markup change.

© 2024 Anthropics Technology Ltd.
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Image before tool

Image with tool

33
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Image after tool

For more information, consult the shape tools reference 62

2.5.3 Skin

The skin section allows you to manipulate the skin texture and tighten the stomach region. This only applies to
the body. To manipulate skin on the face, use the face section.

markup canvas

When the skin section opens, a second copy of the image appears on the left of the image
that we are editing. This is in grayscale, but with a red mask superimposed to indicate the
current estimated skin region. This will determine which parts of the image are changed by
this section.

© 2024 Anthropics Technology Ltd.
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The automatically selected skin region is usually approximately correct. However, if it is not
correct, the topmost slider (select skin area) increases or decreases the amount of skin
selected. To further refine the skin region, use the mark skin or remove skin tools to directly
add or subtract from the skin area in the left panel.

The remaining controls in the skin section are used to manipulate the texture of the skin. The
smooth skin tool smooths the selected skin area to provide an airbrushing effect. The tuck
belly slider tones the stomach region to reduce fat and increase definition. The belly button
drop down menu allows you to replace the belly button with a different choice. If the new belly
button is not in the correct position, you can change it by dragging the white control point on
the left panel.

The tool bar at the bottom, contains tools to select the skin, remove skin, smooth, remove
blemishes, restore, lighten and darken. We define the effects of each below:
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add skin tool

When this tool is selected, and the mouse is moved over the leftimage, a cursor consisting of two concentric
circles appears. When you paint on the canvas, skin is selected by finding any areas in the larger circle that
match the colors in the smaller circle. A preview of the area that will be selected is updated directly. When this
tool is selected two sliders appear underneath, that control the size of the concentric circles.

remove skin tool

This tool has the opposite effect of the add skin tool -- instead of adding to the selected skin region, it
decreases the selected skin region. As with the add skin tool, two sliders appear under the tool which control
the concentric circles in the cursor.

smooth tool

The smooth skin tool allows you to locally smooth an area in the image. Itis applied by clicking and dragging
directly on the right-hand image. The size of the area over which the effectis applied and the strength of the
effect are controlled by two sliders which appear when this tool is selected. The tool will work even on regions
which have not been selected as skin, and the region you smooth will be added to the skin mask.

remove blemishes tool

The remove blemishes tool is used to remove spots, moles, tattoos and other local features on the skin. It
makes an estimation from the edge of the circular cursor. The size of the region and the strength of effect can
be adjusted using sliders that appears under the tool when itis selected.

restore tool

The restore tool reverts the skin in the circular cursor back to the original state. The size of the affected region
and the strength of effect can be adjusted using sliders that appear under the tool when itis selected.

brighten skin tool

The lighten tool locally brightens the image when the user clicks on the right-hand canvas. This could be used
to decrease shadows which might make a region look flatter. The size of the affected region and the strength of
effect can be adjusted using sliders that appear under the tool when itis selected.
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darken skin tool

The darken tool locally decreases the intensity of the image when the user clicks on the right-hand canvas.
This could be use to increase shadows which might make a region look less flat. The size of the affected
region and the strength of effect can be adjusted using sliders that appear under the tool when itis selected.

For more information, consult the skin section reference[ 64
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254

Face

The face section is used to make changes to the subject's face. When you click on this section, the view will
zoom into the face region and a second canvas opens on the left-hand side. This new canvas shows the
estimated markup of the facial feature points. If the points are in the wrong place, the controls in this section
will not work properly. To change the markup, simply click and drag the points to the correct position.

Please note that the face section is intended only for frontal faces. To indicate that the face is not frontal, click
the Face not frontal button thatis superimposed over the left (markup) canvas to disable this section.

The face section consists entirely of sliders which are manipulated in the right-hand panel and make changes
to the main canvas. They broadly fall into three categories:

0 Shape sliders -- these allow you to change the overall shape of the face and also to manipulate its
components (e.g eye size).

0 Smoothing sliders -- these allow you to smooth the skin in the facial region.

o Lighting sliders -- these allow you to relight the face so that the picture is more flattering.

Note that the companion product PortraitPro is specialized to making face changes and contains many more
controls for changing the shape and appearance of facial portrait photos.

For more information, consult the face section reference[ 64
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255 Warp fixer

The warp fixer is used to correct areas of the background that have become distorted due to body reshaping.
When you click on this section, the view will zoom out to show the whole image and a second canvas will open
on the left-hand side. This new canvas is your working window for selecting warped areas to be fixed.

INGERGN £

Warped areas are defined using patches. These are then straightened and preserved by the software. There
are three tools for defining patches:

Line Patch

Click and hold to create a patch that follows a straight line that has become warped. Examples of this might be
wall edges or horizon lines. Hold SHIFT while dragging to create a break in the patch, release SHIFT to resume
drawing the patch. Use ESCAPE (ESC) to cancel while selecting.

Brush Patch
Use this tool to paint over a small area that has become warped. Hold SHIFT while painting to create a break in
the patch. Release SHIFT to resume drawing the patch. Use ESC to cancel while selecting.

Patch Eraser
Use this brush to remove areas from a patch. Use ESC to cancel while selecting.
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warp fixer

Line Patch

Paint a patch over a line that has
become distorted. Hold Shift to pause
painting. Use Escape to cancel while
painting.

Patch Controls

= O B B

Patch Properties

strength

stickiness

Border Properties
strength [ J

stickiness

The Patch Controls let you adjust the effects of the warp fixer.

Select Patches
Click on a patch to selectit. Click and drag over several patches to selectthem all. Selected patches will be
contained within a yellow box.

Delete Patches
Deletes all selected patches.

Group Patches
Groups all selected patches to that they will behave and move in the same way when warp fixing is applied.

Ungroup Patches
Ungroups selected patches so that they can behave and move in different ways.

Patch Properties and Border Properties
These sliders adjust the strength and effects of the warp fixing on your subject and the rest of the image.
Adjusting them will change how much of an effect you see on your final image.
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25.6 Picture

The Picture section tackles overall changes to the contrast, brightness and color palette of the whole image,
similar to those found in more conventional image editing tools. All of the effects are achieved by moving the
sliders in the control column directly.

picture

]
]
]
]
]
L
L
L
L

The sliders consist of:

black and white -- converts the image to black and white

sepia -- converts the image to sepia

auto levels -- an intelligent transformation that tries to generally improve the image

contrast -- increases or decreases the contrast of the image while leaving the average brightness and
color unchanged

exposure -- adjusts the overall brightness of the image

temperature -- adjusts the color of the whole image to remove any temperature (red-blue) color cast
tint -- adjusts the color of the whole image to remove anytints (green-purple) color cast

vibrance -- makes the colors in the picture more intense

saturation -- similar to vibrance, but has less effect on colors that are less intense

recover exposure -- recovers over-exposed areas

fill light -- fills in shadows

blacks -- darkens black regions in the image

O 0O oo

O OO0 O0OO0OO0OOo0OOo

For more detail, see Picture tools[ 73

2.6 Group Shots

Working with group shots

If there is more than one person in your image, you will need to save the image and re-open itto start working
on another bodyin the image.
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3.1

Reference

This section provides information about the different menu commands and controls in PortraitPro Body.
The Homepage Reference[44)page describes the application home page.

The Menu Commands[461page describes each menu command.

The Marking Up the Bodylzﬁ page describes each of the controls available when you markup an imagelﬂﬁ.
The Enhancing the Bodyl?lh page describes the controls that are available when you enhance an image.

Homepage

When you load the program or close a project, the home page will be shown.

¥ | PortraitPro Body 3

From the homepage, you can:

o Edita newimage

o Load an existing project

o Re-load a recently-used project

o Open a tutorial concerning a particular aspect of the software

Projects

To load a new image, click the new image button. To load an existing project, click the open project button. You
can open a window that do either job by pressing the space bar while on the home page. Alternatively (and
from any pointin this software), you can press CMD+O or use Open from the File menu.

All of these actions bring up open file dialogs. In this window, you can choose the project orimage that you
wish to open.
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Recentfiles

Below the open file button are icons representing the eight mostrecently used projects. In each case a
thumbnail of the body that was manipulated and the file name are provided. Click on the appropriate icon to
resume working on this project. This section will only appear after you have saved your first project file.

Getting started

The Getting Started section contains the overview video (which is run the firsttime that you load the software)
and four other tutorials, each of which consists of a short video and a project to work on. The user is
encouraged to work their way through these tutorials when they first open the software.

Learn more

The Learn More section contains a number of further tutorials that help explain other parts of the software. This
section opens up after the getting started tutorials have been run.

Scaling slider

The slider in the top right-hand of the homepage allows the user to rescale all of the elements of the user
interface. Move this slide to make everything smaller or larger so that it suits the screen that you are working on.
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3.2 Menu Commands

These are the commands available on the menu bar in PortraitPro Body.

@ PortraitProBodyStd File Edit View Help

File Commands to open and save files, print, or change settings

Edit Undo & Redo

View Commands to control the visibility and appearance of various elements of the user interface

Help Commands to launch help, check for updates, get support, or view about box
Menul 48)

3.2.1 File Menu

The File menu contains the following commands:

Open... Opens either an image or a project file (see Supported File Types W).

If a file is already open with unsaved changes, you will be prompted to save
or discard the changes before the new file is opened.

Save Project Saves the projectin the native (.prb") format. If the project has not previously
been saved, the File Save panel will be shown prompting you for a
filename.

This command is only available at the enhancing the body stage[54.

Save Project As... Saves the currentfile. This is similar to the Save command, except thata
File Save panel is always shown to let you select where to save the file.
This command is only available at the enhancing the body stage[58,

Export Image... Saves the currentfile. The firsttime this command is used after opening a
file, the following rules apply:
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If you opened a JPEG file, the enhanced image will be saved as a JPEG.
If you opened a PNG file, the enhanced image will be saved as a PNG.

If you opened a TIFF file or any RAW file type (Studio edition only), the
enhanced image will be saved as a TIFF.

All other file types can be saved as JPEG, TIFF or PNG, and can be
selected from the file types.

From then on, this command will save the same type of file as previously
saved.

This command is only available at the enhancing the body stage[54),

Share Connects to Facebook and posts a before / after photo with a comment.
This command is only available at the enhancing the bodystagelaﬁ.

Close /Homepage Closes the current session. If there are any unsaved changes, you will be
prompted to save or discard these.

The Close command returns you to the Homepage[44),
Print... Brings up the Print dialog that lets you print out the enhanced image.
Exit Closes the application. If there are any unsaved changes, you will be

prompted to save or discard these.

Note: On Macs, this command is called "Quit PortraitPro Body"' and is in the
PortraitPro Body application menu.

Plug-in Mode

If the application is in plug-in mode[ 17, then the onlycommand in the File menu is Return From Plug-in, which
returns the enhanced image to the calling application and closes PortraitPro Body.

3.2.2 Edit Menu

The Edit menu contains the following commands:

Undo Provides undo for changes to slider values and changes made with the brush tools.

This means itis safe to experiment with different saved settings, or try moving any
sliders, since you can always go back to the result you had earlier if you don't like the
changes.

This command is only available at the enhance image stage.

Redo Lets you redo an operation that has been undone with the Undo command.

© 2024 Anthropics Technology Ltd.



48 PortraitPro Body 3.6

3.2.3 View Menu

The View menu contains th

Before and After

Markup Help

Scale

Animate

Homepage tips

Rendering

3.24 Help Menu

The Help menu contains th

Contents
Quick Start Guide
Keyboard Shortcuts

Check For Updates...

Support...

About

e following commands:

Toggles the workspace between a single canvas (after) or two canvases side by
side (before and after).

Toggles whether the Instructions panel is shown to the right of the markup screen.

Change the size of the fonts and interface elements to make the elements larger
or smaller.

Starts an animation showing how the image has changed (click on the canvas to
stop).

Turns the “Did You Know?” section on the homepage on or off.

Choose whether image rendering is handled by your GPU or CPU. This can assist
with certain rendering issues on lower end/higher end machines.

e following commands:

Launches the online help, showing the Table of Contents.

Launches the online help showing the Quick Start Guide[ 7™,

Launches the online help showing the Keyboard Shortcuts [8D),
Launches the default web browser to show whether you have the latest
version of PortraitPro Body.

If updates are available, links will be provided for you to download them.
Launches the default web browser to show the PortraitPro Body support
pages.

You can use this to find answers to common questions, or to contact the
PortraitPro Body support team.

Brings up the About Box, which shows the version of PortraitPro Body that you
have.

Note: on Macs, this command is in the PortraitPro Body application menu.
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3.3 Marking Up the Body

After loading in a new image, there are a series of markup stages that must be carried out by the user before
the image can be edited.

These are:

o Identifying the person that we wish to edit
o lIdentifying the gender of the person that we have chosen
o Checking and confirming the markup

Markup Help

Throughout the markup stages, an Instructions window is available to provide guidance. By default this is
visible and is on the right-hand side of the main canvas. You can hide and reveal this window by choosing
Markup Help from the View menu.

The help typically consists of several pages. The the first set of pages describe how to mark the placement of

the nose. The other pages deal with adjusting the curves. To view these other pages, click on the relevant tab
on the help window. During the markup tutorials, this help will be specific to the image that you are marking up.

3.3.1 Select Face reference

To identify the person that you want to edit, move the mouse over the center of the tip of their nose. If the face is
identified successfully by the software you will now be asked to identify the gender.
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Occasionally, the software will fail to identify the face based on your click. This sometimes happens when the
face is close to profile or is partially obscured by hair or another object. When this happens, the software will
prompt you to check that you have selected the right location. The face may not have been detected because
you clicked on the wrong image position in the first stage. If this is the case, simply click the Cancel button
when prompted. If the selection is correct, click Yes. The software will then attempt to locate the body again but
you may need to make more detailed adjustments to the markup.

Special cases:

Face turned away If the face is turned away, then make your best guess as to where the nose
would be.

Nose hidden If the nose is hidden by another object then guess where itwould be.

Nose out ofimage If the nose is out of the image then click where you guess it would be. You can
pan the image using CMD + mouse drag or via the navigator in the top right
corner.

© 2024 Anthropics Technology Ltd.



Reference 51

3.3.2 Adjusting the markup reference

Once the software has selected the outline of the body, you may wish to make some adjustments.

Adjusting the curves

This proceeds in the fixed order:

Rightarm curves

Leftarm curves

Right leg curves

Leftleg curves

Torso curves

To adjust the curve, use the LEFT mouse button to click and drag one of the white circle points to the
appropriate position. The goal is to have the skeleton points in the center of the limbs and the curves points
running along the outlines. When you drag a curve point, you may see a white rectangle appear, the point must

be kept within the constraints of this area.

To move on to the next curve area, click the right arrow displayed on the screen or press the SPACEBAR. To go
back to the previous curve area, click the left arrow displayed on the screen or press BACKSPACE.

You can also navigate between areas by clicking the colored numbers on the left-hand control panel.

Female Torsos

For the female torso, the curves should be marked around the breasts.
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Special cases

Limb obscured Ifthe limb is hidden by another part of the body or object, then guess where the
curves would be if they were not obscured.

Baggy clothes If the limb is obscured by baggy clothing, then make your best guess as to where
the body curves would be.

Adjust overlaps

The software will automatically detect when one limb is in front of another. To change this selection, use the
radio buttons on the control column. Where overlaps have been automatically detected, these will already be
turned on. if they are incorrect, simply click the boxto turn it off again. The overlaps will be represented on
screen to help you visualize the overlap.
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4. adjust overlaps
:_I left lower leg in front of right lower I
:I right lower arm in front of torso

] right upper arm in front of torso

torso in front of right upper leg

] left upper leg in front of right upper leg

Once you've finished making your adjustments, click accept markup and edit body to begin editing the image.
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3.4

Editing the Image

This section describes the main controls available when you are editing an image.

NEGER S

navigator

markup

shape sliders

slim
lift

built

shape tools
skin

face

Canvases

After Photo - By default only the edited image will be shown, to the right of the control panel.

Before Photo - Shows the original image. For some tools (such as the warp fixer) this will also be your
working window for making selections.

To pan either canvas, hold CMD and drag the canvas with the mouse. To zoom in and out, use the + and - keys.
Alternatively you can use the navigator panel.[56)

Viewing the enhanced image
The tab to the left of the images controls the layout of the working view.
¢ Click on the Side by Side tab to return to the side by side layout.

¢ Click on the Hide Original tab to have only the enhanced image shown.

Flipping between the enhanced and original image

Whichever layout you have, you can press the ENTER key at any time to switch from the enhanced image view
to show the original image. The original image is only shown while you hold down the ENTER key.
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This lets you flip between the enhanced and original image which is a great way to see the changes.

Alternatively, you can click and hold the mouse button down on the tab above the images that says Hold For
Original. If you SHIFT - Click this tab, the system will smoothly animate between the original and enhanced
images.

Toolbar
The toolbar contains buttons for:

Home / Close -- close the current project and return to home screen
Save Project -- save the current project

Export Image -- save the edited image

Share -- Post a before / after picture to Facebook

Undo -- Undo the last change

Redo -- Redo the last undone change

Help -- Opens a context sensitive help that guides you around the screen

O OO0 O0OO0OO0oOOo

Navigator

The navigator in the top-left corner helps you move around the canvas. It provides controls for zooming to fit the
image, zooming into the body, and zooming to the face of the current subject as well as controls for panning
and zooming. More details can be found in the pavigator reference[56).

Markup

Clicking on the markup header returns to the markup section so that you can edit the body markup if you made
a mistake. Note that all of your edits to the image will be lost if you choose this option.

Edit Sections

These are grouped into the following sections:

shape sliders -- make large scale changes to the shape of the body by dragging sliders.
shape tools -- make finer scale changes to the body shape using brushes and tools.

skin -- make changes to the skin texture and appearance.

face -- make changes to the shape and appearance of the face.

warp fixer -- correct areas of the background that have been distorted by the body shaping.

picture -- make global changes to aspects of the image such as brightness and contrast.
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3.4.1 Navigator
The navigator is in the top left corner of the markup and editing screens.

It lets you see what part of the whole image is visible in the working view. It also provides controls to let you
zoom in and out, or pan the current view.

navigator

The Navigator contains the following controls:

Header bar Lets you collapse the navigator to create extra space.

Click again to expand the Zoom control.

Help button The help button triggers the context sensitive help system which helps explain the
controls in this section.

Zoom Slider Lets you zoom in (slide to the right) or out (slide to the left).

"zoom to fit" Button Zooms the view so thatthe whole image is visible.

"zoom to body' Button | Zooms the view so that the view is centered on the current body.

"zoom to face" Button Zooms the view to the face.

The rectangle in the Zoom Control can be dragged to pan the view.
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+ Zoom in

- Zoom out

1 Zoom so thatwhole image is visible
2 Zoom so that body is visible

3 Zoom so thatthe face is visible

You can also pan the image by holding down CMD and dragging the canvas with the mouse.

3.4.2 Shapesliders

The shape sliders allow you to make large changes to the shape of the subject.

® ® @ o

®
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L
L
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L
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The shape sliders section contains the following controls:

Header bar Lets you collapse the shape slider section.
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Click again to expand the shape sliders control.

On/Off button

Lets you turn the shape changes on or off.

To reset the shape changes, use this button to turn them off and then
make new changes by moving the sliders.

This button also turns on or off the shape tools section.

Help button

The help button triggers the help system which helps explain the
controls in this section.

Sliders

Each slider allows you to change the shape in a different way.
To move the slider, click on the handle and drag to the left or right.
To reset the slider, double click on it.

If a slider will have no effect then it will be grayed out and showed as
inactive.

The parts of the image affected by the slider can be previewed by clicking
on its name.

Expand sliders button

Opens up a new section or subsection of sliders.

Collapse sliders button

Collapse a section or subsection of sliders.

Master Sliders

slim

Makes the body slimmer overall.

curvy (women only)

Makes the waist smaller and the hips and chestlarger.

built (men only)

Widens the shoulders and narrows the waist.

lift

Lifts the chest, abdomen and bottom.

tall

Lengthens the limbs and torso.

Torso Sliders

master Changes the size of the entire torso.
chest Changes the size of the chest.
waist Changes the size of the waist.
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hips Changes the width of the hips.
abdomen Changes the size of the abdomen (same as waist slider if frontal view).
bottom Changes the size of the bottom (same as hips if frontal view).

chest height

Lifts the chest vertically.

abdomen height

Lifts the abdomen vertically.

bottom height

Lifts the bottom vertically.

Arm Sliders
master Changes the size of both arms.
left Changes the size of the leftarm.
left upper Changes the size of the upper leftarm.
left lift Lifts the region bellow the upper left arm.
left lower Changes the size of the lower left arm.
left wrist Changes the size of the left wrist.
right Changes the size of the right arm.
right upper Changes the size of the upper right arm.
right lift Lifts the region below the upper right arm.
right lower Changes the size of the lower right arm.
right wrist Changes the size of the right wrist.

Leg Sliders
master Changes the size of both legs.
left Changes the size of the left leg.
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left upper Changes the size of the left upper leg.

left thigh Changes the size of the upper part of the left upper leg.
left knee Changes the size of the left knee.

left lower Changes the size of the left lower leg.

left ankle Changes the size of the left ankle.

right Changes the size of the right leg.

right upper Changes the size of the right upper leg.

right thigh Changes the size of the upper part of the right upper leg.
right knee Changes the size of the right knee.

right lower Changes the size of the right lower leg.

right ankle Changes the size of the right ankle.

Skeleton Sliders

neck length

Moves the head parallel to the torso.

face position

Moves the head perpendicular to the torso.

shoulder width

Widens the shoulders.

left elbow Moves the left elbow towards or away from the body (sometimes useful
when slimming the torso to avoid a tear in the image).

right elbow Moves the right elbow towards or away from the body (sometimes useful
when slimming the torso to avoid a tear in the image).

hips angle Changes the angle of the hips.

torso length

Changes the length of the torso.

hip height Moves the hips up or down, and hence changes the ratio of the torso
length to leg length.
leg length Increases the length of the legs.

© 2024 Anthropics Technology Ltd.




Reference

61

© 2024 Anthropics Technology Ltd.




62

PortraitPro Body 3.6

3.4.3

Shape tools

The shape tools section provides a number of tools for editing the shape of the person in the image by directly
manipulating the image. In general these tools make finer scale changes to the image than is possible with

the shape sliders.

The shape tools section contains the following controls:

Header bar

Allows you to collapse the shape tools section.

Click again to expand the shape tools section.

On/Off button

Allows you to turn the shape changes on or off.

To reset the shape changes, use this button to turn them off and then make new
changes by using the tools.

This also turns on or off the shape slider section.

Help button

The help button triggers the context sensitive help system which helps explain the
controls in this section.

Tools

Each tool makes different types of changes to the body.
Click on the slider icon to selectit.

Press the TAB button repeatedly to cycle through the tools.

Current tool

The current tool is highlighted and the name is shown below the tool icons.

Abrief description of the tool is also shown.

Tool sliders

For some tools, sliders will appear under the tool icons that control the size and
strength of the tool.

To reset the sliders, double click on them.
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Keyboard Shortcuts

[ Decrease tool size (where applicable)

] Increase tool size (where applicable)

9 Decrease tool strength (where applicable)

0 Increase tool strength (where applicable)

TAB Moves to next tool

SHIFT When held switches to alternate tool -- edit body to edit bodylocal and vice-versa,

expand to contract and vice-versa, repeat to revert.

edit body tool

When this tool is selected, and the mouse is moved over the image, the curves on the edge of the body and will
be highlighted. You can use this tool to pick up the curves and move them. The program knows about the
statistics of human body shape and so tries to find a solution thatis compatible with the current mouse
position but also sensible. So, for example, if you move the left-hand side of the torso in then the right-hand
side of the torso will also move in. Once a point has been moved, itis fixed unless another pointis placed
nearby.

When the move curves tool is selected, itis also possible to move the skeleton joints, which are represented
as colored dots at the joint positions. To move the joints simply drag them to a new position.

editbody local tool

The local curve tool allows you to make fine scale local changes to the curve. To move a curve, simply click on it
and move the mouse to drag itto a new position. Only curve positions very close to the mouse will be affected.
When this tool is selected, a slider will appear that controls the size of the region over which the local change is
affected.

drag tool

The drag tool can be used anywhere in the image -- itis used to locally deform the shape of the image by
clicking and dragging the mouse. Acircle surrounding the cursor allows you to visualize the area which will be
dragged. When this tool is selected, sliders appear on the right-hand panel that control both the area over
which the change is made and the strength of the change.

expand tool

The expand tool can also be used anywhere in the image and causes a local expansion or dilation within the
circular cursor region when the mouse is held down. When this tool is selected, sliders appear on the right-
hand panel that control both the size of the cursor and the strength of the effect.
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3.4.4

contract tool

The contract tool can also be used anywhere in the image and causes a local contraction or shrinking within
the circular cursor region when the mouse is held down. When this tool is selected, sliders appear on the right-
hand panel that control both the size of the cursor and the strength of the effect.

repair / revert tools

The repair tool fixes problems with the shape of the image by making the shape changes locally smooth within
the circular window. Occasionally, movement of the sliders, or use of the other shape tools will cause tears,
discontinuities, or unrealistic shape changes. Applying the repair tool by holding the mouse down over the
desired area, will gradually fixthese problems. When this tool is selected, sliders appear on the right-hand
panel that control both the size of the cursor and the strength of the effect.

If the SHIFT button is held down, the repair tool switches to the revert tool. This has the effect of locally restoring
the shape of the image to its original state. As well as meaning that the shape changes are locally smooth, it
also returns objects to their original position.

fix bulges / pinches tool

The fix bulges / pinches tool is a very specific tool for sorting out problems in the shape that are at a finer scale
than the curve tools can deal with. Typically, it would be used to reduce bulges at the hips, or creases due to fat
or a tight bikini strap. To operate the tool, move the cursor over one of the existing curves. The region under
consideration is blown up and the shape is visualized before and after the change. Pressing and holding the
mouse button causes the shape change to be made. Essentially, the local shape of the contour in the image is
estimated and warped towards the smoother (but usually more desirable) curves that were drawn in the
markup change.

Skin tools

The skin tools section provides a number of tools for editing the skin of the person in the image and tighten the
stomach region by either moving sliders, or by directly manipulating the image. This only applies to the body --
to manipulate skin on the face, use the face section.

The skin section allows you to manipulate the skin texture and tighten the stomach region. This only applies to
the body -- to manipulate skin on the face, use the face section.
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Markup canvas

skin

add skin

his brush to add skin on the left pane

The skin section contains the following controls:

header bar

Click to select the skin section.
Lets you collapse the skin section.

Click again to expand the skin section.

on/off button

Lets you turn the skin changes on or off.

To reset the skin changes, use this button to turn them off and then make new
changes by using the controls.

This also turns on or off the skin slider section.

help button

The help button triggers the context sensitive help system which helps explain the
controls in this section.

select skin area

Moving this slider increases or decreases the amount of skin selected on the
markup canvas.

smooth skin This slider smooths the region of skin selected on the markup canvas.
tummy tuck This slider replaces the stomach region with a more toned version.
belly button The belly button drop down menu allows the replacement of the current belly button

with various different options. The position of the new belly button can be
manipulated by a control on the markup canvas.
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Skin Tools

Below the skin sliders are a set of tools for selecting and editing the skin.

tools

current tool

tool sliders

The tools are as follows:
add skin

remove skin

smooth skin

remove blemishes

restore

Each tool makes different types of changes to the skin.
Click on the slider icon to selectit.

Press the TAB button repeatedly to cycle through the tools.

The currenttool is highlighted and the name is shown below the tool icons.

Abrief description of the tool is also shown.

For some tools, sliders will appear under the tool icons that control the size and
strength of the tool.

To reset the sliders, double click on them.

When this tool is selected, and the mouse is moved over the leftimage, a cursor
consisting of two concentric circles appears. When you paint on the canvas, skin is
selected by finding any areas in the larger circle that match the colors in the smaller
circle. Apreview of the area that will be selected is updated directly. When this tool
is selected two sliders appear underneath, that control the size of the concentric
circles. Holding SHIFT while this tool is selected switches to the remove skin tool.

This tool has the opposite effect of the add skin tool -- instead of adding to the
selected skin region, it decreases the selected skin region. As with the add skin
tool, two sliders appear under the tool which control the concentric circles in the
cursor. Holding SHIFT while this tool is selected switches to the add skin tool.

The smooth skin tool allows you to locally smooth an area in the image. Itis
applied by clicking and dragging directly on the right-hand image. The size of the
area over which the effectis applied and the strength of the effect are controlled by
two sliders which appear when this tool is selected. The tool will work even on
regions which have not been selected as skin, and the region you smooth will be
added to the skin mask.

The remove blemishes tool is used to remove spots, moles, tattoos and other local
features on the skin. It makes an estimation from the edge of the circular cursor.
The size of the region and the strength of effect can be adjusted using sliders that
appears under the tool when itis selected.

The restore tool reverts the skin in the circular cursor back to the original state. The
size of the affected region and the strength of effect can be adjusted using sliders
that appear under the tool when itis selected.
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brighten skin

darken skin

Keyboard Shortcuts

The lighten tool locally brightens the image when the user clicks on the right-hand
canvas. This could be used to decrease shadows which might make a region look
flatter. The size of the affected region and the strength of effect can be adjusted
using sliders that appear under the tool when itis selected.

The darken tool locally darkens the image when the user clicks on the right-hand
canvas. The size of the affected region and the strength of effect can be adjusted
using sliders that appear under the tool when itis selected.
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[ Decrease tool size (where applicable)
] Increase tool size (where applicable)
9 Decrease tool strength (where applicable)
0 Increase tool strength (where applicable)
TAB Moves to next tool
SHIFT When held switches to alternate tool -- edit skin to remove skin and vice-versa,
brighten to darken and vice-versa
3.45 Facetools

The face section is used to make changes to the subject's face. When you click on this section, the view will
zoom into the face region and a second markup canvas opens on the left-hand side. Dragging the points will

adjust the face selection.

Markup canvas

ighting contrast

modeling light

smoke

The skin section contains the following controls:

Header bar

Click the face section.

Lets you collapse the face section.
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On/Off button

Help button

Sliders

Expand sliders button

Collapse sliders button

Click again to expand the face section.

Lets you turn the face changes on or off.

To reset the face changes, use this button to turn them off and then make
new changes using the controls to begin again.

The help button triggers the context sensitive help system which helps
explain the controls in this section.

Each slider allows you to change the face in a different way.
To move the slider, click on the handle and drag to the left or right.

To reset the slider, double click on it.

Opens up a new section or subsection of sliders.

Collapse a section or subsection of sliders.
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Controls

shape

jaw

forehead

widen eyes

smile

smooth skin

around eyes

lighting contrast

modeling light

smokey eyes

This slider makes overall changes to the shape of the face.

Expanding the slider will display the jaw and forehead sliders.
This slider makes changes to the jaw shape.

This slider makes changes to the forehead shape.

The widen eyes slider increases the size of the eyes.

The smile slider makes small changes at the corners of the mouth to
increase the degree to which the person is smiling.

The smooth skin slider smooths the skin over the entire face.

This slider smooths the skin around the eyes of the subject to remove bags
and wrinkles.

Increases or reduces the amount of contrastin the face lighting.
Relights the image in a way that emphasises the contours the face.

Darkens the area around the eyelids to add definition.

Note that the companion product PortraitPro is specialized to making face changes and contains many more
controls for changing the shape and appearance of facial portrait photos.
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3.4.6 Picturetools

These controls affect the whole image and allow you to adjust the overall look of the picture, controlling things
like the contrast and color temperature.

picture

°
®
®
®
]
®
®
[ ]
[ ]

The picture section contains the following controls:

Header bar Click the picture section.
Lets you collapse the picture section.

Click again to expand the picture section.

On/Off button Lets you turn the picture changes on or off.

To reset the picture changes, use this button to turn them off and then make new
changes using the controls to begin again.

Help button The help button triggers the context sensitive help system which helps explain the
controls in this section.

Sliders Each slider allows you to change the picture in a different way.
To move the slider, click on the handle and drag to the left or right.

To reset the slider, double click on it.

Sliders
black and white Desaturates the image. At 100, the image will be black and white.
sepia Takes the picture from color to sepia and anywhere in between.
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auto levels

contrast

exposure

temperature

tint

vibrance

saturation

recover exposure

fill light

blacks

Example

Automatically sets the levels so that the darkest thing in the picture is black and the
brightest thing is white.

Increases or decreases the contrast of the whole image in such a way so as to bring
out the detail but leave the average brightness and color of the image unchanged.

Adjusts the overall exposure (brightness) of the whole image.

Adjusts the color temperature of the whole image. Move right to increase the amount
of red or left to increase the amount of blue.

Adjusts the color tint of the whole image. Move right to increase the amount of green
or leftto increase the amount of magenta.

Adjusts the overall vibrance of the whole image. Increasing the vibrance will make
the colors in the picture more intense. Decreasing the vibrance will make the colors
less intense (more gray).

Adjusts the overall color saturation (color intensity) of the whole image. Vibrance and
Saturation are similar effects, the difference is that vibrance has less effect than
saturation on colors that are less intense. Neither slider affects areas that are black,
white or gray.

If part of a picture is very overexposed, it will recover some of the detail in the
overexposed areas.

Brightens areas of shadow.

Adjusts the black point of your image, or how dark the darkest areas appear.
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3.5

3.6

Plug-in Installation Guide

Studio Edition Only

Installing the PortraitPro Body Photoshop Plug-in

In the Studio editions of PortraitPro Body, you have the option to use PortraitPro Body as a plug-in[ 17 from
Photoshop and other compatible photo editing suites.

During installation, the installer will auto-detect any compatible applications.

Once you have confirmed which applications you would like the plug-in to be installed for, progress with the
installation as normal and both PortraitPro Body and the selected plug-ins will be installed.

Re-installing plug-ins

If you did notinstall the plug-ins when PortraitPro Body was installed, perhaps because you did not have the
other application already installed at thattime, you can install the plug-in later.

To do this, run the installer for PortraitPro Body again.

Troubleshooting

If the PortraitPro Body plug-in does not appear in Photoshop (or other compatible application), it may not have
installed correctly. This can be caused by the plug-in being installed into the wrong folder.

To fix this, you need to find the correct folder for the plug-in to be installed into. Usually the plug-in install
location is "/Applications/<APPLICATION-NAME>/Plug-Ins" for example, "/Applications/Adobe Photoshop
CS5/Plug-ins/".

Third Party Credits

PortraitPro Body uses a number of third-party libraries, which are acknowledged here. We offer our thanks to
the authors for providing these valuable resources.

dcraw

RAW image reading is provided by dcraw.

Copyright 1997-2012 by Dave Coffin, dcoffin a cybercomo net

tifflib
TIFF image reading and writing is provided by libtiff.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Gaphics, Inc.

Perm ssion to use, copy, nodify, distribute, and sell this software and its
docunentation for any purpose is hereby granted wi thout fee, provided that (i) the
above copyright notices and this perm ssion notice appear in all copies of the

sof tware and rel ated docunentation, and (ii) the nanes of SamLeffler and Silicon
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Graphics nmay not be used in any advertising or publicity relating to the software
wi thout the specific, prior witten perm ssion of Sam Leffler and Silicon G aphics.

THE SOFTWARE | S PROVIDED "AS-1S" AND W THOUT WARRANTY COF ANY KI ND, EXPRESS, |MPLIED OR
OTHERW SE, | NCLUDI NG W THCQUT LI M TATI ON, ANY WARRANTY OF MERCHANTABI LI TY OR FI TNESS
FOR A PARTI CULAR PURPCSE.

I'N NO EVENT SHALL SAM LEFFLER COR SILI CON GRAPH CS BE LI ABLE FOR ANY SPECI AL,

I NCI DENTAL, | NDI RECT OR CONSEQUENTI AL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTI NG FROM LOSS OF USE, DATA OR PRCFITS, WHETHER OR NOT ADVI SED CF THE PGSSI Bl LI TY
OF DAMAGE, AND ON ANY THECRY OF LIABILITY, AR SING QUT OF OR | N CONNECTI ON WTH THE
USE OR PERFORVANCE OF THI S SOFTWARE.

jpeglib
JPEG image reading and writing is provided by jpeagtiff.
This software is based in part on the work of the |Independent JPEG G oup.

This software is copyright (C 1991-2011, Thonas G Lane, Quido Vol | bedi ng.

pnglib
PNG image reading and writing is provided by pnglib.

zlib
Zlib compression supportis provided by zlib.

(O 1995-2012 Jean-loup Gailly and Mark Adler

Adobe DNG SDK
DNG reading is provided by the Adobe DNG SDK.
Lossl ess JPEG code adapted from

Copyright (C 1991, 1992, Thomas G Lane.
Part of the Independent JPEG G oup's software.

Copyright (c) 1993 Brian C. Smth,
The Regents of the University of California
Al rights reserved.

Copyright (c) 1994 Kongji Huang and Brian C. Snith.
Cornel |l University
Al rights reserved.

Perm ssion to use, copy, nodify, and distribute this software and its documentation
for any purpose, w thout fee, and without witten agreenment is hereby granted,

provi ded that the above copyright notice and the foll owing two paragraphs appear in
all copies of this software.

IN NO EVENT SHALL CORNELL UNI VERSITY BE LI ABLE TO ANY PARTY FCR DI RECT, | NDI RECT,
SPECI AL, | NCI DENTAL, OR CONSEQUENTI AL DAVAGES ARI SING QUT OF THE USE CF THI S SCFTWARE
AND | TS DOCUMENTATI ON, EVEN | F CORNELL UNI VERSI TY HAS BEEN ADVI SED OF THE PGCSSI BI LI TY
OF SUCH DANMAGE.
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CORNELL UNI VERSI TY SPECI FI CALLY DI SCLAI M5 ANY WARRANTI ES, | NCLUDING BUT NOT LIM TED
TO THE | MPLI ED WARRANTI ES OF MERCHANTABI LI TY AND FI TNESS FCR A PARTI CULAR PURPCSE.
THE SOFTWARE PROVI DED HEREUNDER |S ON AN "AS | S" BASIS, AND CORNELL UNI VERSI TY HAS NO
OBLI GATI ON TO PROVI DE MAI NTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODI FI CATI ONS.

Copyright © 2006 Adobe Systens Incorporated. Al rights reserved.

Adobe is a registered trademark or tradenmark of Adobe Systens Incorporated in the
United States and/or other countries. Wndows is either a registered trademark or a
trademark of Mcrosoft Corporation in The United States and/or other countries. Mac is
a trademark of Apple Conputer, Inc., registered in the United States and ot her
countries. Al trademarks noted herein are the property of their respective owners.

Adobe XMP SDK
The Adobe XMP SDK is used by the Adobe DNG SDK

Copyri ght 2009 Adobe Systens |ncorporated and others. Al rights reserved. The
original version of this source code may be found at http://adobe. com

Icms library

ICC color profile handling is provided by lcms.
Little CVB

Copyright (c) 1998-2007 Marti Maria Saguer

Permi ssion is hereby granted, free of charge, to any person obtaining a copy of this
sof tware and associ ated docunentation files (the "Software"), to deal in the Software
wi thout restriction, including without limtation the rights to use, copy, nodify,
nerge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permt persons to whomthe Software is furnished to do so, subject to the follow ng
condi tions:

The above copyright notice and this perm ssion notice shall be included in all copies
or substantial portions of the Software.

THE SOFTWARE | S PROVIDED "AS | S', W THOUT WARRANTY OF ANY KIND, EXPRESS OR | MPLI ED,

I NCLUDI NG BUT NOT LIM TED TO THE WARRANTI ES OF MERCHANTABI LI TY, FI TNESS FOR A

PARTI CULAR PURPCSE AND NONI NFRI NGEMENT. | N NO EVENT SHALL THE AUTHORS OR COPYRI GHT
HOLDERS BE LI ABLE FOR ANY CLAIM DAMAGES OR OTHER LI ABI LI TY, WHETHER I N AN ACTI ON CF
CONTRACT, TORT OR OTHERW SE, AR SI NG FROM QUT OF CR | N CONNECTI ON W TH THE SOFTWARE
OR THE USE OR OTHER DEALINGS I N THE SOFTWARE.

OpenCV
Automatic feature finding makes use of the OpenCV library.
Li cense Agreenent
For Open Source Conputer Vision Library
Copyright (C) 2000-2008, Intel Corporation, all rights reserved.
Copyright (C) 2008-2011, WIllow Garage Inc., all rights reserved.

Third party copyrights are property of their respective owners.
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Redi stribution and use in source and binary forns, with or without nodification, are
permtted provided that the followi ng conditions are net:

* Redistributions of source code nust retain the above copyright notice, this list
of conditions and the follow ng disclainer.

* Redistributions in binary formmnust reproduce the above copyright notice, this
list of conditions and the follow ng disclainer in the docunentation and/or other
materials provided with the distribution.

* The nane of the copyright holders nmay not be used to endorse or pronote products
derived fromthis software without specific prior witten permssion.

This software is provided by the copyright holders and contributors "as is" and any
express or inplied warranties, including, but not limted to, the inplied warranties
of nerchantability and fitness for a particular purpose are disclainmed. In no event
shall the Intel Corporation or contributors be liable for any direct, indirect,
incidental, special, exenplary, or consequential damages (including, but not limted
to, procurenent of substitute goods or services; |oss of use, data, or profits; or

busi ness interruption) however caused and on any theory of liability, whether in
contract, strict liability, or tort (including negligence or otherwise) arising in any
way out of the use of this software, even if advised of the possibility of such
damage.

Machine Learning Framework

Amachine learning framework is provided by Darwin.

DARWN A FRAMEWORK FOR MACHI NE LEARNI NG RESEARCH AND DEVELCOPMENT
Copyright (c) 2007-2012, Stephen Gould

Al rights reserved.

Redi stribution and use in source and binary forns, with or without nodification, are
permtted provided that the follow ng conditions are met:

* Redistributions of source code nmust retain the above copyright notice, this |ist
of conditions and the foll ow ng disclainmner.

* Redistributions in binary formmst reproduce the above copyright notice, this
list of conditions and the follow ng disclainer in the docunmentation and/or other
materials provided with the distribution.

* Neither the name of the software's copyright holders nor the names of its
contributors nay be used to endorse or pronote products derived fromthis software
wi t hout specific prior witten perm ssion.

TH' S SOFTWARE | S PROVI DED BY THE COPYRI GHT HOLDERS AND CONTRI BUTCRS "AS | S' AND ANY
EXPRESS OR | MPLI ED WARRANTI ES, | NCLUDI NG BUT NOT LIM TED TO, THE | MPLI ED WARRANTI ES
OF MERCHANTABI LI TY AND FI TNESS FOR A PARTI CULAR PURPCSE ARE DI SCLAI MED. | N NO EVENT
SHALL THE COPYRI GHT HOLDER COR CONTRI BUTORS BE LI ABLE FOR ANY DI RECT, | NDI RECT,

I NCIl DENTAL, SPECI AL, EXEMPLARY, OR CONSEQUENTI AL DAMAGES (I NCLUDI NG BUT NOT LI M TED
TO PROCUREMENT OF SUBSTI TUTE GOCDS OR SERVI CES; LOSS OF USE, DATA, OR PROFITS; OR
BUSI NESS | NTERRUPTI ON) HOAEVER CAUSED AND ON ANY THEORY OF LI ABILITY, WHETHER I N
CONTRACT, STRICT LIABILITY, OR TORT (I NCLUDI NG NEGLI GENCE OR OTHERW SE) ARI SING | N ANY
WAY QUT OF THE USE OF TH S SOFTWARE, EVEN | F ADVI SED OF THE PGSSI BI LI TY OF SUCH
DAVACE.
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Boost

General classes are provided by boost.

Boost Software License - Version 1.0 - August 17th, 2003

Perm ssion is hereby granted, free of charge, to any person or organi zati on obtaining
a copy of the software and acconpanyi ng docunentati on covered by this |license (the
"Software") to use, reproduce, display, distribute, execute, and transmt the
Software, and to prepare derivative works of the Software, and to permt third-parties
to whomthe Software is furnished to do so, all subject to the follow ng:

The copyright notices in the Software and this entire statenent, including the above
license grant, this restriction and the foll ow ng disclaimer, nust be included in all
copies of the Software, in whole or in part, and all derivative works of the Software,
unl ess such copies or derivative works are solely in the formof nachi ne-executable
obj ect code generated by a source | anguage processor.

THE SOFTWARE | S PROVIDED "AS | S', W THOUT WARRANTY OF ANY KIND, EXPRESS OR | MPLI ED,
I NCLUDI NG BUT NOT LIM TED TO THE WARRANTI ES OF MERCHANTABI LI TY, FITNESS FOR A

PARTI CULAR PURPCSE, TI TLE AND NON- | NFRI NGEMENT. I N NO EVENT SHALL THE COPYRI GHT
HOLDERS COR ANYONE DI STRI BUTI NG THE SOFTWARE BE LI ABLE FOR ANY DAVAGES OR OTHER

LI ABI LITY, WHETHER | N CONTRACT, TORT OR OTHERW SE, ARI SING FROM QUT COF CR IN
CONNECTI ON W TH THE SOFTWARE OR THE USE OR OTHER DEALINGS | N THE SOFTWARE.

Delaunay Triangulation
A Delaunay triangulation function is provided by Ken Clarkson, AT&T.
Ken C arkson wote this. Copyright (c) 1995 by AT&T.

Perm ssion to use, copy, nodify, and distribute this software for any purpose w thout
fee is hereby granted, provided that this entire notice is included in all copies of
any software which is or includes a copy or nodification of this software and in all
copi es of the supporting docunentation for such software.

TH' S SOFTWARE | S BEING PROVIDED "AS | S', WTHOUT ANY EXPRESS CR | MPLI ED WARRANTY. I N
PARTI CULAR, NEI THER THE AUTHORS NCOR AT&T MAKE ANY REPRESENTATI ON CR WARRANTY OF ANY

KI ND CONCERNI NG THE MERCHANTABI LITY OF TH' S SOFTWARE OR I TS FI TNESS FCR ANY PARTI CULAR
PURPCSE.

gt-google-analytics
Copyright (c) 2014-2015, University of Applied Sciences Augsburg

Al rights reserved.

Redi stribution and use in source and binary forns, with or wthout
nmodi fication, are permtted provided that the follow ng conditions are net:
* Redistributions of source code nmust retain the above copyright
notice, this list of conditions and the follow ng disclainer.
* Redistributions in binary formmnmust reproduce the above copyright

notice, this list of conditions and the follow ng disclaimer in the
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docunentati on and/or other materials provided with the distribution.
* Neither the name of the University of Applied Sciences Augsburg nor the
names of its contributors may be used to endorse or pronote products

derived fromthis software without specific prior witten perm ssion.

TH S SOFTWARE | S PROVI DED BY THE CCPYRI GHT HOLDERS AND CONTRI BUTCRS "AS |'S" AND
ANY EXPRESS OR | MPLI ED WARRANTI ES, | NCLUDI NG BUT NOT LIMTED TGO THE | MPLI ED
WARRANTI ES OF MERCHANTABI LI TY AND FI TNESS FOR A PARTI CULAR PURPCSE ARE

DI SCLAI MED. | N NO EVENT SHALL THE CCPYRI GAT OANER OR CONTRI BUTCRS

BE LI ABLE FOR ANY DI RECT, | NDI RECT, | NCI DENTAL, SPECI AL, EXEMPLARY, OR
CONSEQUENTI AL DAMAGES (I NCLUDI NG, BUT NOT LIM TED TO PROCUREMENT OF SUBSTI TUTE
OODS OR SERVI CES; LOSS OF USE, DATA, OR PRCFITS; OR BUSI NESS | NTERRUPTI ON)
HONEVER CAUSED AND ON ANY THECRY OF LIABILITY, WHETHER | N CONTRACT, STRICT
LIABILITY, OR TORT (I NCLUDI NG NEGLI GENCE OR OTHERW SE) ARI SI NG I N ANY WAY

UT OF THE USE OF THI'S SOFTWARE, EVEN | F ADVI SED OF THE PGCSSI Bl LI TY OF SUCH DAMAGE.

3.7 Supported File Types

PortraitPro Body can read and write the following types of files:

Type Extension Description
JPEG Jpg; .jpeg Image file type that uses lossy compression
TIFF tif; tiff Image file type thatis uncompressed or uses loss-less compression

Note: TIFF files containing images that have 16 bits per color sample (48 bits
per pixel) are only supported in the Studio edition.

PNG .png Image file that uses loss-less compression

PRB .prb Proprietary file type used by PortraitPro Body to store a session

Studio Edition

In addition, PortraitPro Body Studio supports reading the following camera RAW files:

Manufacturer Type

Adobe .dng
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ARRI ari

Canon .Ccrw; .cr2
Epson erf

Fuji raf

Imacon fff

Kodak tif; .kdc; .der
Mamiya .mef; . mos
Minolta mrw

Nikon .nef
Olympus .orf
Panasonic raw; .rw2
Pentax ptx; .pef
Phase One tif; iig

Red .r3d
QuickTake gtk

Sigma Xx3f

Sony .arw; .srf; .sr2
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3.8 Keyboard Shortcuts

PortraitPro Body provides the following keyboard shortcuts at the various stages of the application.

Menu Commands

CMD+0O Fle > Open command
CMD+S Fle > Save Project command
CMD+W Fle > Close command
CMD+I Fle > Export image command
CMD+Z Edit > Undo command
CMD+Y Edit > Redo command
CMD+A Edit > Animate command
Start Screen
CMD+0O Brings up File Open dialog to let you select the file to open
All modes
+ Zoom in
- Zoom out
CMD Temporarily move to panning mode
1 Zoom to image
2 Zoom to body
3 Zoom to face

Editing modes

RETURN Flip to original when held

ENTER Flip to original when held

TAB Move to next brush

[ Make brush smaller

] Make brush larger

9 Decrease brush strength

0 Increase brush strength

SHIFT Temporarily switch to alternate tool
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Shape Tools 7, 10, 28, 54, 57
Bulges and Pinches 30, 62
Contract region 30, 62
Edit body local Tool 30, 62
Edit body Tool 30, 62
Expand Tool 30

Skeleton 7, 10, 20, 49

Skin 7, 10, 34, 64, 68

Sliders 28, 30, 57, 62

Slim Slider 28, 57

Start 7

Support 6, 11, 46
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Tall Slider 28, 57
TIFF 11, 46, 74, 79
Torso 7,49
Tummy Tuck 34
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View Menu 46, 48
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Warp Fixer 39
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